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Legal Notices

Warranty
The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an 
additional warranty. HP shall not be liable for technical or editorial errors or omissions contained 
herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HP required for possession, use or copying. 
Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software 
Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government 
under vendor's standard commercial license.

Copyright Notice
© Copyright 1994-2013 Hewlett-Packard Development Company, L.P.

Trademark Notices
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This 
product includes software written by Tim Hudson (tjh@cryptsoft.com). Smack software copyright 
© Jive Software, 1998-2004. SVG Viewer, Mozilla JavaScript-C (SpiderMonkey), and Rhino 
software Copyright © 1998-2004 The Mozilla Organization. This product includes software 
developed by the OpenSSL Project for use in the OpenSSL toolkit. (http:// www.openssl.org). 
OpenSSL software copyright 1998-2005 The OpenSSL Project. All rights reserved. This project 
includes software developed by the MX4J project (http://mx4j.sourceforge.net). MX4J software 
copyright © 2001-2004 MX4J Team. All rights reserved. JFreeChart software © 2000-2004, Object 
Refinery Limited. All rights reserved. JDOM software copyright © 2000 Brett McLaughlin, Jason 
Hunter. All rights reserved. LDAP, OpenLDAP, and the Netscape Directory SDK Copyright © 
1995-2004 Sun Microsystems, Inc. Japanese Morphological Analyzer © 2004 Basis Technology 
Corp. The Sentry Spelling-Checker Engine Copyright © 2000 Wintertree Software Inc. Spell 
Checker copyright © 1995-2004 Wintertree Software Inc. CoolMenu software copyright © 2001 
Thomas Brattli. All rights reserved. Coroutine Software for Java owned by Neva Object 
Technology, Inc. and is protected by US and international copyright law. Crystal Reports Pro and 
Crystal RTE software © 2001 Crystal Decisions, Inc., All rights reserved. Eclipse software © 
Copyright 2000, 2004 IBM Corporation and others. All rights reserved. Copyright 2001-2004 Kiran 
Kaja and Robert A. van Engelen, Genivia Inc. All rights reserved. Xtree copyright 2004 Emil A. 
Eklund. This product includes software developed by the Indiana University Extreme! Lab (<http:// 
www.extreme.indiana.edu/>). Portions copyright © Daniel G. Hyans, 1998. cbg.editor Eclipse 
plugin copyright © 2002, Chris Grindstaff. Part of the software embedded in this product is gSOAP 
software. Portions created by gSOAP are copyright © 2001-2004 Robert A. van Engelen, Genivia 
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Inc. All Rights Reserved. Copyright © 1991-2005 Unicode, Inc. All rights reserved. Distributed 
under the Terms of Use in http:// www.unicode.org/ copyright.html.

Adobe™ is a trademark of Adobe Systems Incorporated.

Java™ is a registered trademark of Oracle and/or its affiliates.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.

UNIX® is a registered trademark of The Open Group.

For a complete list of open source and third party acknowledgements, visit the HP Software 
Support Online web site and search for the product manual called HP Service Manager Open 
Source and Third Party License Agreements.
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Documentation Updates
The title page of this document contains the following identifying information:

 l Software Version number, which indicates the software version.

 l Document Release Date, which changes each time the document is updated.

 l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go 
to:

      http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport 
ID, go to:

      http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support 
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:

      http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support 
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As a 
valued support customer, you can benefit by using the support web site to:

 l Search for knowledge documents of interest

 l Submit and track support cases and enhancement requests

 l Download software patches

 l Manage support contracts

 l Look up HP support contacts

 l Review information about available services

 l Enter into discussions with other software customers

 l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also 
require a support contract. To register for an HP Passport ID, go to:

      http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to: 

      http://h20230.www2.hp.com/new_access_levels.jsp
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This document is an overview of the changes made to HP Service Manager 9.21 for patch 7. It 
contains important information that is not included in other documentation. 
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What's New in This Release
This section describes important changes in this release.

Important:              Based on customer feedback, the overall quality of Service Manager has been an 
area of concern over the last number of years. To that end, the Service Manager R&D team 
has spent a significant amount of effort improving the quality of Service Manager, and recent 
customer feedback is very positive. Many defects that have been in the product for many years 
are now fixed in the SM 9.3x. The issues resolved in this build patch cover only the most 
critical fixes.  To gain better performance and user experience, we strongly recommend that 
you apply the latest binaries from SM 9.3x instead of this build patch.

     In most cases SM 9.3x binaries are compatible with SM 7.1x and SM 9.2x applications. 
Therefore,  you are not required to perform a full upgrade to take advantage of the latest Service 
Manager technology.  Specific compatibility details are listed in the SM 9.3x release notes.         

Updating the Java Plug-in When Using Firefox 17+
As of this release, the SM9.21 Web client supports Firefox 17+.

However, if your web client has an outdated JRE version installed, Firefox 17+ will block the Java 
Plugin. As a result, some display problems might occur in the web client (for example, workflow 
graphics cannot be displayed correctly).

Therefore, if your Java Plugin is blocked by  Firefox 17+, you are strongly recommended to update 
your Java Platform Plugin.

Activate your JRE7 plugin if blocked by Firefox

Due to a security enhancement in JRE7, Firefox may deactivate your JRE7 plugin for your safety.  
When this happens, a red plugin icon appears in the address bar, next to your web client URL 
string. For example, when you open the web client with  ?telephonyuser=1 appended to its URL, 
Firefox deactivates the JRE7 plugin; as a result, Service Manager cannot function properly (for 
example, cannot execute a telephony call).  In this case, you need to activate your JRE7 plugin for 
your Service Manager web site as described here:

 1. Click the red plugin icon in the address bar.

A message window opens, as shown below.

HP Service Manager (9.21) Page 8 of 58



 2. Click Activate All Plugins.

 3. Select Always activate plugins for this site.

The red plugin icon now disappears from the address bar.

Embedded JRE Upgraded (Server and Windows 
Client)

This patch release has upgraded the SM server and Windows client embedded JRE  to JRE1.7.

Server

The server embedded JRE for x86 systems has been upgraded  to version 1.7.0_15.

Since the Service Manager server does not come with an embedded JRE for non-x86 systems 
(Solaris, HP-UX, and AIX), users using these platforms need to install one of the following JRE1.7 
versions and make sure server/RUN/jre is a symbolic link pointing to the JRE1.7.

Platform JRE Version

Solaris JRE1.7 (update 15  or greater)

HP-UX JRE1.7 (JRE_7.0.04 or greater)

AIX JRE1.7 (SR4 or greater)

Note: After applying the server patch, if you need to roll back, be sure to restore your  old  JRE. 
See "Backout Instructions" on page 39.

Windows Client

The Windows client embedded JRE has been upgraded to version 1.7.0_17.
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Server Embedded Tomcat Upgraded
In this release, the SM server embedded Tomcat has been upgraded from 6.0.35 to 6.0.36.

This upgrade requires additional steps when installing the server patch. For details, see "Server 
Update Installation" on page 49.

Note: After applying the server patch, if you need to roll back, be sure to restore your  old 
embedded Tomcat. See "Backout Instructions" on page 39.

New Text Strings to Be Localized
This release has introduced a number of new text strings, which customers can easily localize 
using the native2ascii tool. 

Naming Convention of Localized Files
Localized versions of resource files use the following naming convention: <basename>_<language_
code>.properties or <basename>_<language_code>_<country_code>.properties. 

Note: The file names are case-sensitive.

The following are two examples.

Example File Description 

cpe_rcp_en.properties “cpe_rcp” is the base name, and “en” is the language code.

cwc_labels_zh_
CN.properties

“cwc_labels” is the base name, “zh” is the language code, and “CN” 
is the country code.

For a list of language codes (and country codes if any) used in the file names of localized resource 
files, see the following table.

Language Code Country Code Description

  Default

en  English

ar  Arabic

cs  Czech

de  German (Standard)

es  Spanish (Spain)
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Language Code Country Code Description

fr  French (Standard)

hu  Hungarian

it  Italian (Standard)

ja  Japanese

ko  Korean

zh CN Chinese (PRC)

nl  Dutch (Standard)

pt BR Portuguese (Brazil)

ru  Russia

Service Manger uses UTF-8 as the default encoding when interpreting the resources. It requires all 
resources files in native UTF-8 encoding be converted to files containing Latin-1 and/or Unicode-
encoded characters, using the native2ascii tool.

New Text Strings to Be Localized
The following table lists the removed or added text strings in the Web tier and Windows client of this 
release, as well as their corresponding properties files.

Removed or Added Text Strings Description

<Service_Manager_Root/Client/plugins/com.hp.ov.sm.client.eclipse.rcp_
9.21.624/rcp.jar>/com/hp/ov/sm/client/eclipse/rcp/cpe_rcp.properties

Added:

 l HelpError=Help Error

 l HelpDocumentationNotInstalled=Documentation 
is not installed.

New strings were added for the 
message window that opens when 
users click the Help Contents 
option in the Windows client.

Note: These new strings are 
required due to the Rich Client 
Platform (RCP) version upgrade to 
support JRE1.7.

<Service_Manager_Root/Client/plugins/com.hp.ov.sm.client.eclipse.user_
9.21.624/user.jar>/com/hp/ov/sm/client/eclipse/user/controller/cpe_controller.properties

HP Service Manager (9.21)Page 11 of 58

Patch 7 Release Notes
What's New in This Release



Removed or Added Text Strings Description

Removed:

 l TopazClient.lostserver_2=The HP Service 
Manager server could not be accessed. The 
network connection may be down, or your 
session may have timed out. Would you like 
to retry accessing the server? Press Yes to 
retry or No to disconnect

Added:

 l TopazClient.lostserver_msg1=The HP Service 
Manager server could not be accessed. The 
network connection may be down. Would you 
like to disconnect with server or retry to 
access? Press Yes to disconnect or No to 
retry.

 l TopazClient.lostserver_msg2=Your server 
session may have been terminated or timed 
out. Would you like to disconnect with 
server now? Press Yes to disconnect or No to 
cancel.

New messages were added to 
distinguish between session 
termination and network 
disconnection.

How to Localize New Text Strings
Step 1. Set up the Java development environment on Windows.

 1. Download and install Java Standard Edition 6 or later.

 2. Set the JAVA_HOME variable and add <JAVA_HOME>/bin to the system path.

 3. Open the system command prompt, and run the following command to check if Java has been 
correctly configured:

java  -version

Note: If your Java development environment is ready, this command will print your Java 
version information.

Step 2. Convert the text in a specific language to Unicode.

As an example, the following provides the localization steps for Japanese. The steps for other 
languages are similar.
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 1. Translate the added resource text to the target languages, and put the translated text in a text 
file for each language: <basename>_<language>.txt.

 2. Merge your translated resource text for all properties files into one file, so that you can convert 
all of the text in one go. For instance, for Japanese, put the translated text in sm921p7_RES_
ja.txt.

Note: Make sure its file encoding is UTF-8 (You can copy an existing file in Service 
Manger and then edit it).

The following is an example of translated text, which is provided for demonstration purposes 
only.

# From chMBundle.properties

TITLE=タスクプランナー

MANDATORY=必要に応じてマーク\ /読み取り専用の変更のようにプロパティを設定します。

TASK_CONDITION=タスクの状態

END_PHASE_INVALID=エンドフェイズでは、スタートフェーズの後に発生する必要があります

#From cwc_labels.properties 

Framework.CollapseNav=崩壊·ナビゲータ

Framework.ExpandNav=ナビゲータを展開

Framework.CommandLineField=コマンドライン

Framework.CommandLineBtn=実行する

cwc.skipLink=スキップしてメインページに進む

 3. Copy sm921p7_RES_ja.txt to a local folder. For example: C:\sm921p7.

 4. Open the system command prompt, and change current directory to the local folder you 
selected in the previous step (for example:C:\sm921p7).

 5. Run the following native2ascii command to convert the text.

native2ascii -encoding utf-8 sm921p7_RES_ja.txt  sm921p7_RES_ja.properties

The converted text should look like the following (the following text is provided for 
demonstration purposes only).

#From cwc_labels.properties

Framework.CollapseNav=\u5d29\u58ca\u00b7\u30ca\u30d3\u30b2\u30fc\u30bf

Framework.ExpandNav=\u30ca\u30d3\u30b2\u30fc\u30bf\u3092\u5c55\u958b

Framework.CommandLineField=\u30b3\u30de\u30f3\u30c9\u30e9\u30a4\u30f3
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Framework.CommandLineBtn=\u5b9f\u884c\u3059\u308b

cwc.skipLink=\u30b9\u30ad\u30c3\u30d7\u3057\u3066\u30e1\u30a4\u30f3\u30da\

u30fc\u30b8\u306b\u9032\u3080

Tip: For more information on the usage of the native2ascii tool, see 
http://docs.oracle.com/javase/1.4.2/docs/tooldocs/windows/native2ascii.html . 

Step 3. Append the localized new strings to the localized version of the resource files.

 1. In the sm921p7_RES_ja.properties file, copy the lines from cwc_labels.properties to 
<webtier-9.21>/WEB-INF/classes/com/hp/ov/cwc/web/cwc_labels_ja.properties.

 2. In the sm921p7_RES_ja.properties file, copy the lines from each of the remaining properties 
files and append them to the Japanese version of the files.

Now, the localization process for Japanese is complete.

 3. Restart your web application server and Windows client.

New Parameters and RAD Functions
This release introduces the following new parameters and RAD function.

 l "Startup parameter: maxloginspercluster" below

 l "RAD function: datecmp" on the next page

Startup parameter: maxloginspercluster
Startup parameters change the behavior of the Service Manager server. You can always set a 
startup parameter from the server's OS command prompt.

Parameter
maxloginspercluster

Description
In a horizontal scaling implementation, Max Logins for operators is enforced at the cluster level. 
This parameter allows administrators to turn off this feature. By default, this parameter is set to 
1, which means Max Logins for operators is enforced by counting each operator's logins on all 
cluster hosts; when this parameter is set to 0, only logins on the local host are counted.

Valid if set from
Server's OS command prompt
Initialization file (sm.ini)

Requires restart of  Service Manager server?
Yes

Default value
1
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Possible values
0 ((Disable Max Logins at the cluster level)
1 (Enable Max Logins at the cluster level)

Example usage
Command line: sm -httpPort:13080 -maxloginspercluster:0
Initialization file: maxloginspercluster:0

RAD function: datecmp
A RAD function that translates date/time fields to the correct SQL statement dialect. You can use 
this function  in expert search of incidents, as well as in  JavaScript programming.

See also QCCR1E52991.

Function
datecmp

Format
datecmp("DateTimeField1","LogicOperator","DateTimeField2","+/-", "TimeInterval")

Parameters
This function uses the following arguments.

Argument Description Example Value (s)

DateTimeField
1

A date time field in a Service Manager 
table. 

close.time

LogicOperator  A logic operator. >, >=, =,  <=,  <

DateTimeField
2

Another date time field in the same 
Service Manager table.

open.time

+/- Arithmetic operator: +or -. +, -

TimeInterval A string that represents the time 
interval to be added to or subtracted 
from the second date time field. 

The format of time interval can be: d, d 
hh:mm:ss, d h:m:s, hh:mm:ss, h:m:s, 
or hh:m:ss (1 digit mixed with 2 digits). 
Days can be omitted, or at most 9 
digits.  Hours, minutes, and seconds 
can be 1 or 2 digits (from 0 to 99), and 
hour:minute:second as a whole can be 
omitted if you enter only days. 

10 02:03:04

(This string represents 10 days, 2 
hours,  3 minutes and 4 seconds.)

Notes:
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 l All arguments must be enclosed in a pair of double quotes; otherwise the query parsing will 
fail.

 l This function supports "AND"/"OR"/"NOT" to concatenate multiple datecmp() calls in one 
query. 

The following are two examples:

datecmp("close.time", "<", "open.time","+", "1") or datecmp("close.time",">=", 
"open.time","+", "5:0:0") 

problem.status="Closed"  and (not datecmp("close.time",">", "open.time", "+","31 
04:02:30"))

 l You can combine the result of this function  with other query conditions to construct a 
complete query. For example, you can execute one of the following queries when performing 
an expert search of incidents: 
 n  problem.status="Closed"  and datecmp("close.time","<","open.time","+","04:02:30") and 

datecmp("close.time",">=","open.time","+","02:02:30" )

 n  problem.status="Closed"  and datecmp("open.time",">","close.time", "-", "04:02:30" ) and 
datecmp("close.time",">=","open.time","+","02:02:30" )

 n  problem.status="Closed"  and datecmp("close.time",">", "open.time", "+","31 04:02:30")

Note: The first two queries should return the same results, which are  incidents whose closed 
time is between 2 hours and 4 hours from their open time; the third query should return 
incidents that were closed  more than 31 days after their open time.

.  

Example
An example of a JavaScript program that uses this function is as follows:

var f = new SCFile('probsummary', SCFILE_READONLY);

var query = 'problem.status="Closed" and datecmp("close.time", "<", "open.time",
"+", "04:02:30") and datecmp("close.time",">=", "open.time","+", "02:02:30")';

if (RC_SUCCESS == f.doSelect(query))

{

do

{

print(f);

}

while (RC_SUCCESS == f.getNext());

};
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Certifications
This release includes the following support matrix changes.

Added Support

 l Tomcat 6.0.36 (web application server)

 l Firefox 17 (web client)

 l JRE 1.7  (server, web client, and Windows client)

 l RHEL 5.7 (Knowledge Management server)

Discontinued Support

 l Firefox 10, 15 (web client)

 

For more information, see the compatibility matrix for Service Manager 9.21 on the Software 
Support Online (SSO) site (http://support.openview.hp.com/sc/support_matricies.jsp).
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Enhancements
This release includes the following enhancements.

CR Module Problem Solution

QCCR1E83966 Web Tier As JRE 6 is approaching its end of life, 
support for JRE 7 on the web client is required 
for all supported versions of Service Manager.

JRE 7 on the Web client is now supported for 
Service Manager 9.21p7  or later.

QCCR1E88963 Web Tier Firefox 17 is not supported for the web tier. Firefox 17 is now supported for the web tier.

QCCR1E47888 Applications Knowledge Management Search Engine 
(Verity K2) needs to be updated to support 
RHEL 5.7.

Knowledge Management Search Engine (Verity 
K2) now supports RHEL 5.7.
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Fixed Defects
This release fixes the following defects.

Server

CR Problem Solution

QCCR1E8986 Using a type of TIMESTAMP in a dbdict SQL 
mapping on an Oracle database causes soap 
faults and a signal 11 error when saving data into 
the column. Service Manager will not 
automatically choose this data type, but users are 
able to manually map a database field to a SQL 
type of TIMESTAMP.

SQL type of TIMESTAMP in dbdict on Oracle no longer 
causes signal 11 when saving data into the column.

QCCR1E49614 If you have record list enabled in the client, sorting 
QBE lists in descending mode becomes very 
slow as compared to when record list is not 
enabled.

Sorting QBE lists in descending mode now becomes faster 
when record list is enabled in the client.

Known issues:

 1. If DB and SM are installed in different machines, the 
sorting speed will be affected by network condition.

 2. The sorting speed will not improve if the customized 
view contains a field of another table.
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CR Problem Solution

QCCR1E52991 In a default Service Manager  system that uses an 
Oracle database, queries that include date and 
time calculations fail because of SQL syntax 
errors. This prevents the creation of a view that 
shows all the interactions that were closed within 
24 hours of being opened.

This issue occurs because the date/time fields arithmetic 
calculation concerned query results are incorrect in SM. This 
is true regardless of the database type. This is due to the lack 
of a generic representation of time interval, and the different 
ways to calculate it in those DB server types.

Added a new RAD function datecmp
("DateTimeField1","LogicOperator","DateTimeField2","+/-", 
"TimeInterval") that translates date/time fields to the correct 
SQL statement dialect.   The function can be used in expert 
incidents searching, as well as in JavaScript programming.

For more information, see "RAD function: datecmp" on page 
15.

QCCR1E59909 You cannot store fields out of sequence in a 
structured array if the structure-type element is 
new to the array.  This issue occurs because of an 
incorrect JavaScript implementation that causes 
the sequence of filling fields into the structured 
array to fail, if a single field is not first in the 
structure.

The incorrect code that failed to handle a field name with 
array path has been fixed.

QCCR1E64366 If a QBE includes Display List and Value List 
values that are Global Lists, you cannot use that 
field as a value to "Chart By" in the Web client.

The "aggregatable" attribute in the response of "getForm" 
XML specifies whether a field can be put in "chart by" menu 
or not. In this case, the RAD variables affected the value of 
the "aggregatable" attribute even after the attribute was set. 
This behavior has now been corrected.

QCCR1E72305 Severe latency issue occurs when displaying the 
Open New Incident form.

The severe latency issue has been resolved.
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CR Problem Solution

QCCR1E72834 An administrator cannot terminate a session that 
is fetching millions of records. This may occur due 
to a poorly created customer view, which can 
cause servlets to consume too much CPU and 
memory, and then terminate servlets.

Now, administrator can terminate a session that is fetching 
millions of records.

QCCR1E73782 A "Signal 11" error is generated when initializing 
LDAP and the following error message is logged 
in the SM.log file many times:

"A signal 11 was raised in native code. 
Client terminated. Error: Win32 
Exception:0xC0000005 (instruction 
0x61DFF440 while reading address 
0x00000000)"

The "Signal 11" error is no longer generated when initializing 
LDAP. Now the SM application can handle the exception by 
logging the following information in the sm.log file:

The ldapserver isn't set in scldapconfig.

QCCR1E74312 When all floating user license are used, the RTE 
issues the following conflicting messages:

1720( 7152) 04/05/2012 07:31:32 RTE W 
Login from user falcon40 at 
192.168.1.107 rejected. Floating user 
count of 10 has been reached

1720( 7152) 04/05/2012 07:31:32 RTE I 
User falcon40 has logged in and is using 
a Floating license (10 out of a maximum 
10)

Only license consumption information will be printed when a 
user logs in successfully.

QCCR1E74418 An SQL error occurs when you switch from the 
chart tab to TODO queue tab. This issue 
occurs when certain fields in the "Chart by" option 
menu is chosen to generate chart.

All fields in the "Chart by" option menu can now be used to 
generate chart without any error message.
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CR Problem Solution

QCCR1E74528 On ESS, buttons will overlap when display option 
labels are greater than 10-12 characters.

Now, ESS truncates long labels to ensure the buttons do not 
overlap.

QCCR1E75514 WCF client cannot add an MTOM/XOP 
attachment when calling the SM Web service to 
create an incident.

WCF client can add MTOM/XOP attachment when calling 
the SM Web service to create an Incident.

QCCR1E76258 Memory Leak messages are found in the log file 
after the Service Manager system starts and then 
shuts down on Unix.

Fixed the memory leak after the Service Manager system 
starts and then shuts down on Unix.

QCCR1E77062 A user cannot log in when the following conditions 
are true:

 1. The LDAP server is offline.

 2. ldapauthenticateonly is 0.

 3. The operator is mapped to ldap.

 4. ldap is the primary data source 

 5. ldapnostrictlogin is enabled.

When LDAP server is offline, RTE will disable the LDAP 
configuration.

QCCR1E79015 There are some leaks found in automation BAT 
test suites.

Fixed the leaks found in automation BAT test suites.

QCCR1E78996 The base64Decode JavaScript function does not 
work as expected.

The base64Decode JavaScript function now works as 
expected.

QCCR1E79354 SM does not send the <xop:Include> tag together 
with MTOM attachments.

SM  sends the <xop:Include> tag together with MTOM 
attachments as expected.

QCCR1E79410 There is a potential leak in dbmandantSubset. The potential leak has been fixed.
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CR Problem Solution

QCCR1E79524 A potential memory leak may occur when 
compiling application codes.

The allocated memory is freed properly.

QCCR1E79614 Memory leak is found in xsd_request. The leak has been fixed.

QCCR1E79701 Some memory leak is found in JsUnit Test suite 
defined in dbdictCacheTest.js.

Fixed the leak found in JsUnit Test suite defined in 
dbdictCacheTest.js.

QCCR1E80363 JAVA MAIL frequently freezes, which causes the 
eventout table to fill with unsent email.

This issue occurs, because there is no timeout set for the 
mail sessions, which causes the RTE to wait indefinitely.  
Now, when a connection issue occurs, a timeout has been 
added so that mail can be resent when starting the sending 
process after the connection issue is resolved.

QCCR1E84025 Service Manager crashes when executing 
Knowledge Management multi-thread 
concurrency tests.

The Knowledge Management plug-in can now support multi-
thread concurrency operations as expected.

QCCR1E84136 The Coordinator runs out of memory and cannot 
respond to new member's join requests.  This 
issue occurs when a custom load balancer failed 
to join the application cluster, which prevented the 
JGroups from forming properly and the system 
was inaccessible to users.  Termination and 
restoration of the load balancer process resolved 
the issue.

This is a defect in JGroup. A timeout connect method is now 
used in JGroup API to work around this issue.
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CR Problem Solution

QCCR1E84162 When running a load test with a Web service 
implementation, the following message is written 
to the SM log file many times:

"Waiting for current response to be consumed by 
the producer"

Note: The sessions that are connected write 
these messages, while the ones that 
successfully log out do not.

Now, there is a check to see whether a session already timed 
out before a message is written.

QCCR1E84322 When multiple threads access _checkIRQueue() 
and change the alert chain at the same time, it can 
lead to bad collection pointers, and potentially an 
endless loop.

To prevent this behavior, the search and deletion operation 
are now locked within the _checkIRQueue() function.

QCCR1E84337 After upgrading to later releases of the Service 
Manager application and binary files, the 
functionality that tracked how many logins since 
the last reset is removed and this information is no 
longer traced in the operator record.

This functionality is now implemented on the RTE side.

QCCR1E84490 When the RTE detects that the IR file is corrupt, a 
Signal 11 error is received and the system 
crashes.

The RTE will detect when the IR file is corrupt, and will 
prevent the crash.

QCCR1E87640 SCAutoListener enters an infinite loop and leads 
to high CPU utilization.The Service Manager 
session encounters a signal 6 and produced a 
core file.

Added new logic to check whether there is any data read by 
the listener. If no data is read, quit from reading to avoid 
infinite loop.
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CR Problem Solution

QCCR1E87784 When IR detects corruption, Service Manager 
issues the following, misleading messages:

7532(  7124) 10/25/2012 23:15:22  RTE E 
Error 0 in call irReadInP4 - The 
operation completed successfully.

7532(  7124) 10/25/2012 23:15:22  RTE E 
irReadInP4: Failure reading 32768 bytes 
at offset scirexpert:ir.probsummary
(52409176), errno=0 (No error)

The error messages state "The operation 
completed successfully" and "No error" which is 
not the case. This issue occurs when the IR files 
are internal (i.e, mapped to the scirexpert table).

Now, clear messages will be provided. If Error = 0, the first 
message will not be issued:

"RTE E Error 0 in call irReadInP4 - The operation 
completed successfully"
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CR Problem Solution

QCCR1E88044 A TeMIP-SM integration fails with "Out-of-
Memory" errors or otherwise becomes unstable.  
This issue occurs because Service Manager 
processes queries incorrectly and returns all 
records for the table when the database is 
frequently inaccessible.

The "Out-of-memory" error will no longer occur because 
Service Manager now returns the correct records or error 
message even if the database is frequently inaccessible.

If the object.name is the same as the name in the 
"extaccess" table, the correct records will be returned. If not, 
the following xml response will be returned to the client side 
and the error information will be logged in sm.log:

<SOAP-ENV:Envelope xmlns:SOAP-ENV="http://

schemas.xmlsoap.org/soap/envelope/">

   <SOAP-ENV:Body>

     <CreateIncidentResponse 

message="Specified Name Not Found" returnCode="7" 

status="FAILURE" xmlns="http://schemas.hp.com/

SM/7"/>

   </SOAP-ENV:Body> 

</SOAP-ENV:Envelope>

QCCR1E88048 A Signal 11 is received when you use a command 
line that resembles the following to import unload 
file:

sm -log:../logs/load.log -triggers:0 file.load 
../platform_unloads/QCCR1E67610_
SM711P18.unl NULL NULL unix

The Signal 11 error is no longer received when you use this 
command.
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CR Problem Solution

QCCR1E88186 When you add new fields to dbdict, the 
dbdict.alter.g form (which has the SM alters 
button) does not appear.  Even though all fields 
are added as expected, those fields are corrupt.

When the system starts up, it tests whether the current 
process has the privilege to create tables in the DB server by 
trying to create a test table. The test result is saved in shared 
memory and is never tested again. Within the function for this 
procedure, if the test table already exists, the old code does 
not attempt to drop the table and then re-create it.  Instead, 
the function directly returns to the caller with the result that no 
create table privilege is granted.  This bug is fixed now.

QCCR1E88252 KMPlugin Signal 11 occurs when multiple users 
doing full reindex simultaneously.

No Signal 11 occurs when multiple users doing full reindex 
simultaneously.

QCCR1E88266 If Service Manager generates two or more core 
dumps in one thread, the last core dump will 
overwrite the previous ones.

Service Manager now keeps the first two core dumps for one 
thread.

QCCR1E88335 An attempt to add an attachment with a file name 
that ends with a dot, or an attempt to update an 
object that already has an attachment with a file 
name ending with a dot results in termination of 
the session with error "_SCStringValue() pos > 
length".

This issue occurs because a "." at the end of a file is 
considered as the delimiter for the extension.   Now, the 
sequence for the delimiter is "." + any character.

QCCR1E88468 After a patch upgrade, a Signal 11 error occurs 
and the servlets eventually hang.

Now, the signal 11 error disappears and the servlet does not 
hang.

QCCR1E88643 After you log in to Ess.do home page, you cannot 
switch to "View Closed Requests" after you click 
"View Open Requests."

This issue occurs because the RTE copies the start-up 
parameter's values to the global symbol table, so that the 
previous RAD’s start-up parameters overwrite the start-up 
values of the current RAD. This issue has been fixed.
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CR Problem Solution

QCCR1E89093 When attempting to log in, users receive the 
following error and then the servlet eventually 
hangs:

"Authentication failed. Contact your 
system administrator for assistance. 
SOAP Fault occurred: A signal 11 was 
raised in native code. Client 
terminated. Stack trace dumped to sm.log"

This behavior occurs when the user tries to 
connect to the LDAP server by using SSL.

Now, SM uses a thread-safe version of the Openldap library 
to prevent the Signal 11 error.

Note: On all UNIX and LINUX platforms, after applying 
this patch and before starting SM, users need to run the 
"setupLinks.sh" script in the server's RUN directory.

QCCR1E89219 Users cannot log in to SRC on their first or second 
attempts, despite entering the correct login 
credentials. The 3rd login attempt is successful.

Logging in to SRC is now successful after the 1st attempt.

QCCR1E89248 When you audit records, a unique constraint error 
occurs and the records are not added in Oracle.

The primary key is generated in any case.

QCCR1E89395 SRC server fails to start up due to the conflict 
between ESS and SRC startup.

SRC server can start up now.

QCCR1E89779 The RAD function (get.module.license) leaks 
JVM memory when you use the function in a 
horizontally scaled environment.

The JVM memory leak issue has been resolved.

QCCR1E91734 In the server log (sm.log), "Unsupported Java 
version" is misspelled as "Unsupported 
Java verion".

The misspelling has been corrected.
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CR Problem Solution

QCCR1E92344 There are some confusing error messages about 
KM plug-in printed in SM log like the following:

java.lang.NoSuchMethodError: 
stopKMJSListener

The obsolete code that prints confusing message in sm log 
file is removed.

QCCR1E94945 SCAutoListener servlet is not responding in 
5 minutes after startup.

The hang issue does not happen anymore as it was solved by 
adjusting the communication code.
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Application

CR Problem Solution

QCCR1E64357 Details of audit records for a configuration item 
(CI) do not display properly. Specifically, the 
following problems occur: 

 l The audit history in the device.audit.vj 
subform is not shown correctly. 

 l Fields such as operator or the child field of an 
array structure like old.scalar are treated in 
the same way as columns of a table in the 
form.

 l An audit record may have only one operator, 
but may have several old.scalar values. 
However, the form would show only the first 
old.scalar with incorrect value.Or, even the 
first old.scalar value is not shown.

This subform can be revised to show only ordinary fields 
of an audit record and can have a link to jump to a detail 
form to show an array structure of that audit record.  If 
users do need the audit history to show data in array 
structure in old.scalar, try to implement it by tailoring. To 
do this, follow these steps:  

 1. Modify the input of the columns of the 
device.audit.vj subform to set the input value to 
a variable instead of field names. For example, 
substitute $L.old.scalar for column old.scalar.

 2. Prepare the variables in a JavaScript by executing a 
DB query and then call this JS in the display screen 
or format control.  The variables can be shown in the 
subform.

Note: Although the above-described workaround is 
available, be aware that Service Manager already 
supports such a use case. When creating a Subform 
control, you need to fill in the Input field, where you 
can specify the sm database field or variable to 
associate with this control; however, if the database 
field is a complex type, for example, Array type or 
Structure type, you must fill in the Input field using 
this format: ArrayName,FieldName. In this 
example, it is recorded.changes,old.scalar.
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Web Client

CR Problem Solution

QCCR1E53844 Existing Web client message trays are not 
cleared when there are no new messages 
received.

Each tab displays only the latest new message that is 
generated by operations triggered in current tab or new 
notification messages from server. Additionally, 
messages that are already displayed in one message 
tray of a tab will not be displayed in other tabs.

QCCR1E57306 Focus is lost on the record list when the 
viewrecordlist parameter in the web.xml file is 
set to false.

The focus is not lost when the user returns to the list 
from the detail page, regardless of whether the 
viewrecordlist parameter is true or false. This change is 
applied to the list view only. In the group view, all groups 
are collapsed by default. After the user cancels back, the 
focus is no longer set to any specific record.

QCCR1E58337 Two timer widgets cannot be displayed on the 
same format at the same time in the Service 
Manager web client.

Multiple timer widgets can be displayed correctly on the 
same format in the web client.

QCCR1E65826 In Service Manager 9.2, on-screen messages 
do not always display. However, you can view 
the messages that are not displayed by clicking 
the Messages and Alerts icon.

On-screen messages will be always displayed.

QCCR1E65925 A "Permission denied" Javascript error occurs 
when trying to broadcast a message from the 
Web client.

Code change has been made to prevent the “Permission 
Denied” issue.

QCCR1E68768 Some of our users report that the 'navigator' 
pane is empty on the left side of their screen. 
The application shows the area where the 
navigator pane must be, but it is empty.

The browser side timeout was increased to wait for the 
server response, and an unnecessary, costly request 
was removed. This should enable the navigator pane to 
display properly.
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CR Problem Solution

QCCR1E68874 The Employee Self Service (ESS) client has 
overlapping buttons with the French language 
applied.

Note: This can be seen when viewing 
closed requests on ESS.

Now the button does not overlap with each other in the 
ESS mode.

Limitation:

Under the following cases, the label on the button may 
be truncated:

 l The label on the button is too long.

 l The user uses a low screen resolution, for example, 
1024*768.

 l The browser width is resized too small.

QCCR1E70795 When views in the Web tier are refreshed 
multiple times, the columns of any views that 
are grouped shrink.

The columns of any views that are grouped no longer 
shrink.

QCCR1E73067 Internet Explorer has a known issue that certain 
DOM operations cause a security warning if a 
Web page is hosted on a secure Web site. For 
more details, see: 
http://support.microsoft.com/kb/925014

In Service Manager, the toolbar has such use 
case.

This issue was resolved by removing the background 
style of the toolbar buttons before the buttons are 
destroyed. This prevents the security warning from 
appearing when the toolbar buttons are refreshed.

QCCR1E74418 An SQL error occurs when you switch from the 
chart tab to TODO queue tab. This issue 
occurs when certain fields in the "Chart by" 
option menu is chosen to generate chart.

All fields in the "Chart by" option menu can now be used 
to generate chart without any error message.

HP Service Manager (9.21)Page 32 of 58

Patch 7 Release Notes
Fixed Defects

http://support.microsoft.com/kb/925014


CR Problem Solution

QCCR1E79114 A data changed event fires too late when the 
focus leaves a radio button in the Web client 
running in Internet Explorer.

The data changed event fires properly when the focus 
leaves a radio button in the Web client running in Internet 
Explorer.

QCCR1E79534 The calendar widget icon is not rendered in an 
array table from the CM.change.login form.

The calendar widget icon is now rendered correctly in an 
array table.

QCCR1E80153 After logging in through the Web tier under SSL 
and then changing the interactions in Service 
Desk > Interaction Queue several times, the 
following Internet Explorer security message 
appears:

"This page contains both secure and 
nonsecure items".

The warning message now no longer appears.

QCCR1E84640 Session is logged out when clicking on a record 
within a record list in list only mode.

The record is displayed as expected when clicking on a 
record within a record list in list only mode.

QCCR1E88002 The serverHost aand serverPort parameters are 
displayed "null" in the Web tier URL when you 
click the "Login again" link in WebLogic:

"serverHost=null&serverPort=null"

Cookie value is not added if the value is null, hence the 
"Login again" link does not append these parameters.

QCCR1E88272 The &quot HTML character representation is 
incorrectly converted to a quote (") character in a 
multi-line text field.

The &quot HTML character representation is no longer 
incorrectly converted to a quote (") character in a multi-
line text field.

QCCR1E88461 In the ESS client, a 404 error occurs when the 
user attempts to open an attachment.

In the ESS client, now you can open an attachment 
successfully without any errors.

QCCR1E89253 A needless confirmation dialog appears 
when you click the Cancel button from the View 
tab without any modifications.

The confirmation dialog no longer appears when you 
click the Cancel button from the View tab without any 
modifications.
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CR Problem Solution

QCCR1E89659 The URL generated from the makeSCWebURL
() function does not work after you upgrade to 
SM9.21 P6.

The URL generated from the makeSCWebURL() 
function now works as expected.

QCCR1E89928 If you try to directly open a record in Web client 
through a query URL and enter an incorrect 
password on your first attempt to log in, the 
reference to the particular record in the URL will 
be changed and you can no longer open the 
record directly.

Now you can directly open a record in Web client through 
a query URL even if after a failed login.

QCCR1E89976 In Web client, when you type a valid entry into a 
Combo Box or a Comfill with "value List" 
specified and "Combo Button Visible" set to 
true, the typed input gets mixed with the auto-
matched entry.

Now in Web client, when you type a valid entry into a 
Combo Box or a Comfill with "value List" specified and 
"Combo Button Visible" set to true, the typed input is 
successfully auto-completed and will not get mixed with 
the auto-matched entry.

QCCR1E91669 An apostrophe is displayed as “&#39” instead of 
' in the title field in the Web client.

An apostrophe now displays correctly as ' in the Web 
client.

QCCR1E91946 An interaction contains the “&” character in a 
field. After you update and save the interaction 
via the Web client, another “&” is appended 
unexpectedly.

An interaction contains the “&” character in a field. After 
you update and save the interaction via the Web client, 
the current value is kept in the field without an appended 
"&".

 

HP Service Manager (9.21)Page 34 of 58

Patch 7 Release Notes
Fixed Defects



Windows Client

CR Problem Solution

QCCR1E52075 In the Service Manager Windows client, a user 
cannot scroll in a read-only multi-line text box 
window by using the mouse wheel. The slider to 
the right of the window must be used instead.

Note: Mouse wheel scrolling works, if the 
field is read-write.

In Windows client, focus can be set on a read-only multi-
line text widget and the scroll bar responds when using 
the mouse wheel.

QCCR1E53130 After you change the font size or select the 
Restore Defaults from Window > Preferences 
> Appearance on the Windows client, the 
format no longer fits on the screen. This results 
in objects falling off the edge of the form and the 
vertical and horizontal scroll bars are not 
created. This behavior prevents users from 
navigating the form.

Now the scroll bars are shown as expected when a larger 
font is used.
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CR Problem Solution

QCCR1E54677 If a Fill button is clicked after you add an 
attachment to an Incident record, the following 
error occurs when you click on the attachment:

"Could not open attachment."

If the Fill function is not performed, then the 
attachment opens without any errors.

Note: The error occurs before the record 
has saved, between the time at which the 
attachment is added and the Fill action is 
performed.

Now, you can open an attachment in an un-saved record 
even after executing Fill action.
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CR Problem Solution

QCCR1E71043 When a client session to Service Manager is 
terminated (for example, after a timeout or by a 
server termination), the user is prompted 
whether they need to retry or disconnect. 
However, the client does not connect even if the 
user clicks Yes to reconnect.

When a client session to Service Manager is terminated 
(for example, after a timeout or by a server termination), 
the user is prompted whether to disconnect or cancel 
with the following message:

"Your server session may have been terminated 
or timed out. Would you like to disconnect 
from the server now? Press Yes to disconnect 
or No to cancel."

Note: When the user clicks No, the current tabs will 
remain open, allowing the user to do things like 
copying information from the open records.

When the network connection is down, the user is 
prompted whether to disconnect or retry with the 
following message:

"The HP Service Manager server could not be 
accessed. The network connection may be down. 
Would you like to disconnect or retry 
accessing the server? Press Yes to disconnect 
or No to retry."

QCCR1E79222 When a session is terminated, the user receives 
a "Session no longer valid" message on 
every open tab. This is annoying when multiple 
tabs are open.

When a session is terminated, the user receives only 
one "Session no longer valid" message.

QCCR1E83940 In Windows client, when you double-click a 
record in the record list to display its detail 
information, additional actions may occur on the 
detail format.

Now, when you double-click a record in the record list to 
display its detail information in Windows client, no 
additional actions will occur on the detail format.
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Known Problems, Limitations, and Workarounds
The following table lists the known issues discovered in this release.

Global ID Known Issue Workaround

QCCR1E89890 Grouped Views are not correctly updated after logging a new 
incident.

When you log a new incident, to keep consistency with 
actual incidents, the group number is not updated. 

You need to click the Refresh button to update 
grouped Views.

QCCR1E72809 After closing a ticket (such as an Interaction or Incident) and 
returning to the view, the queue is not synchronized correctly.

As a workaround, click the Refresh button to solve the 
view display issue.
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Backout Instructions
If you want to restore your Service Manager system to its original state after installing this patch, 
follow these guidelines.

Server
To backout your server changes, make a backup before installing the patch and then roll back.

Backup

Before applying the server patch, make a backup of the server installation folder. For example, 
C:\Program Files\HP\Service Manager 9.21\Server.

Note: If you have a load balanced system, be sure to back up the server installation folder for 
every server instance respectively.

Backout

To restore your Service Manager server to its original state after installing the patch, do the 
following:

 1. Stop the Service Manager server.

 2. Remove the existing server installation folder.

 3. Copy the backup folder back.

Note: Make sure that the embedded Tomcat is also replaced with the backup as the 
version of the embedded Tomcat may have dependency with specific server version.

 4. Restart the Service Manager server.

Note: If you have a load balanced system, make sure that every server instance is replaced 
with its respective backup.

Web Tier
Backup

Before deploying the new web tier, make a backup of the following items:

 l web.xml file

 l application-context.xml

 l splash screen
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 l style sheets

 l any other customizations you made, including your webtier-9.21.war (webtier-ear-9.21.ear) file.

Backout

To roll back to the old web tier:

 1. Delete or uninstall the existing web tier.

 2. Clear the cache of your web application server (for example, Tomcat).

 3. Redeploy the old web tier.

 4. Restore your old customizations.

Windows Client
To roll back to your old Windows client, you need to do backup before installing the new Windows 
client and then reinstall the previous Windows client.

Backup

 1. Make a backup of your Windows client home folder, for example, 
C:\Users\<username>\ServiceManager. Your connections and personalized settings are 
stored in this folder.

 2. Make a backup of your security configuration files if any (Window > Preferences > HP 
Service Manager > Security). For example, your CA certificates file and client keystore file.

Backout

 1. Uninstall the new Windows client.

 2. Reinstall the previous Windows client.

 3. Restore your old Windows connections and configurations.

Applications
Backup

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are 
recommended to use Unload Manager to make a backup of the files to be modified by an 
unload file, because Unload Manager can create a backup of your old data during the 
installation of the unload; if your application version is other than any of these, Unload Manager 
is not available and you can use Database Manager instead. 

To use Unload Manager to make a backup:
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 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next.

Details of the unload file appear.

 4. Double-click a conflicting object in the table to open the merge tool:

 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.

 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To use Database Manager to make a backup:

 1. Go to Database Manager, select Import/Load from More or the More Actions menu, and 
browse to the unload file.

 2. Click List Contents on the menu bar, to view a list of files that have been updated in this 
unload.

See the following figure for an example.

HP Service Manager (9.21) Page 41 of 58

Patch 7 Release Notes
Backout Instructions



This figure shows the contents of an unload file that contains changes to the following files:

File Record

Process     svc.add.cart

application money.format

Note: The scmessage records listed under each RAD application are 
messages used in this RAD application; no backup is needed for them.

ScriptLibrary svcCartHelper

datadict activity

dbdict activity

Note: The “activity” file with no records actually represents the dbdict 
record of the activity file.

scmessage The record whose message class is “fc” and message number is 1000. 

 3. Go to Database Manager, in the Table field enter a file name you got in step 2, and click the 
Search button.

 4. If the format selection page shows, select the proper format by double-clicking it (for example, 
select the device format for the device file), and then search for the file record.

HP Service Manager (9.21)Page 42 of 58

Patch 7 Release Notes
Backout Instructions



 5. Click More (or the More Actions menu) > Export/Unload after the file record displays.

Note: If Export/Unload is not available, check the Administration Mode check box in 
Database Manager and try again.

 6. In the pop-up window, specify your backup upload file path/name, and click Unload Appl. 

Caution: Make sure that Append to file is selected.

 7. Repeat steps 3 through 6 to back up the rest of the files you got in step 2.

Backout

Tip: You can use Unload Manager (recommended) or Database Manager (if Unload Manager is 
not available in your application version) to roll back to your old data, as described in the 
following.

To roll back to your old data using Unload Manager:

 1. Go to  System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload.

A wizard opens.

 3. Select the unload file generated in the backup process, specify a backup file, and then click 
Next.

Details of the unload file display.

 4. Double-click a conflicting object in the table to open the merge tool:
 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to return to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the backup unload.

 7. Click Finish.

To roll back to your old data using Database Manager:

 1. Go to Database Manager, click More > Import/Load.

 2. Browse to the backup unload file you created.
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 3. Click Load FG.
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Installation Notes
This section provides instructions on installing each component in this patch release.

Digital Signature Notice
HP signs Windows executable files with a digital signature. Since January 2012, this process has 
been updated to use a new VeriSign root certificate. On a Windows system that does not have the 
new VeriSign root or intermediate certificate installed, when the user right-clicks the file and then 
goes to Properties > Digital Signatures > Details, a verification error will display: “The certificate 
in this signature cannot be verified.”

To resolve this issue, either enable Windows Update or download and install the G5 Root certificate 
as documented at: https://knowledge.verisign.com/support/ssl-certificates-
support/index?page=content&actp=CROSSLINK&id=SO19140

Web Tier Installation
The Web Tier update consists of a compressed file, sm9.21.624-P7_Web_Tier.zip. The specific 
upgrade process depends on your particular Web application server, but follows the same steps as 
deploying a new installation. For more information, refer to the Service Manager Interactive 
Installation Guide.

The upgrade does not automatically save your Web Tier customizations. To keep your changes, 
you must save your customized files and replace the new version of these files with your 
customized version.
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Note: The Service Manager introduces important changes to the Web tier Directory structure 
since SM 9.21 Patch 5 release. For more information on these changes, see the release notes 
of SM 9.21 Patch 5 and the “Updates to the Service Manager Web Tier Directory Structure” 
white paper at the HP Software support Web site: www.hp.com/go/hpsoftwaresupport

To install the new Web Tier:

 1. Make necessary backups. For details, see "Backout Instructions" on page 39.

 2. Delete or uninstall the existing webtier-9.21.war (or the webtier.ear-9.21.ear) file.

 3. Clear the cache of your web application server (for example, Tomcat).

 4. Deploy the new webtier-9.21.war (or the webtier.ear-9.21.ear) file following the instructions in 
the Service Manager Installation Guide.

Note:  

 n It is recommended to enable HTTPOnly cookies in your web application server to help 
prevent malicious JavaScript injection. To  enable HTTPOnly cookies, see Enabling 
HTTPOnly cookies in your Web Application Server.

 n It is best practice to deploy with a unique context root. For example: /webtier-
9.21.624

 5. Use a diff utility to compare the new Web tier’s web.xml file against your backed-up version to 
ensure that any new parameters are properly merged into the files used in your final 
deployment. Do this for application-context.xml as well as any other files you may have 
customized (such as style sheets and splash screens).

 6. Make any new customizations necessary for your deployment.

Note: Be sure to set the securelogin and sslport parameters.

 7. Restart the web application server.

Note: Before accessing the new Web Tier, HP recommends that all users empty their 
browser cache.

Enabling HTTPOnly cookies in your Web Application Server

It is recommended to enable HTTPOnly cookies in your web application server to help prevent 
malicious JavaScript injection. Following are some examples for how to enable HTTPOnly cookies 
in different web application servers:
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Web 
Application 
Server

How to Enable  'HTTPOnly' Cookies

Tomcat 6.0.20+ Can be enabled for all web applications in conf/context.xml: 

<Context useHttpOnly="true"> ... </Context>  

Oracle WebLogic  
9.2 MP4, 10.0 
MP2, and 10.3.1

Enabled by default.

Oracle WebLogic 
10.3.0

You need to apply a security patch (p8176461_103_Generic), and after that 
HttpOnly cookies are enabled by default. The security patch can be 
downloaded using My Oracle Support (MOS). 

JBoss 5.1 Enable by setting useHttpOnly=true in the context.xml file, which is located 
in jboss/server/<myserver>/deploy/jbossweb.sar/.

<Context cookies="true" crossContext="true">
   <SessionCookie secure="true" httpOnly="true" />
       

</Context> 
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Web 
Application 
Server

How to Enable  'HTTPOnly' Cookies

IBM WebSphere 
6.1.0.45 and 
7.0.0.27

Enable through the following properties:

 l com.ibm.ws.security.addHttpOnlyAttributeToCookies 

 l com.ibm.ws.webcontainer.httpOnlyCookies

Known issue:

If Service Manager 9.21 is deployed on WAS 7.0.0.27, and FireFox is used 
to search "Approved Document" in the Knowledge Management module, 
you may encounter automatic logout issue.

Follow these steps to fix this issue by removing the incorrect URL for the 
background-image used for the knowledge document:

 1. Log on to the Windows client.

 2. From the Navigation menu, click Knowledge Management > Manage 
Document Types.

 3. Select the Reference record.

 4. Modify the Default View from the Associated Document View view 
list.

 5. Remove the incorrect URL in the CSS class .documentTitle. For 
example, remove the following: 

url("44ee44677b0f021810318488:kmrtBackground.gif:
 kmattachments:2").

 6. Save the change.

 7. Do the same for the other four records to avoid other similar problems.

IBM WebSphere 
8.0.0.5 

Enabled by default.

Windows Client Installation
The Windows client update consists of a compressed file, sm9.21.624-P7_Windows_Client.zip, 
which contains the executable installation files.

To install the Windows client update:
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 1. Stop the Service Manager Windows client.

 2. Make necessary backups. For details, see "Backout Instructions" on page 39.

 3. Uninstall the Service Manager Windows client. (Your connection and personalized settings are 
retained.)

 4. Run setup.exe and install the client by following the instructions in the Service Manager 
Installation Guide.

 5. Check the version in Help > About Service Manager Client.

The client should be Release: 9.21.624.

Server Update Installation
The server update for your operating system (OS) consists of a compressed file, sm9.21.624-P7_
<OS>.zip (or .tar), which contains the Service Manager server files. These files add to or replace 
the files in the [SM Server Root]\ ([SM Server Root]/) RUN, irlang, 
legacyintegration, and platform_unloads directories.

Note: If you have a load balanced system, you must upgrade all server instances.

Caution: This server update will upgrade the embedded Tomcat to version 6.0.36, and 
therefore requires additional steps.

Note: Starting with SM9.21p7, the SM server requires JRE 1.7.  For Windows and Linux,  the 
embedded JRE has already upgraded to version 1.7; for other Unix-based platforms, you need 
to manually perform this JRE upgrade.

The JRE upgrade will cause external web service calls over SSL to fail if the remote endpoint 
does not support Server Name Indication (SNI), which is by default activated in JRE 1.7. Once 
Service Manager is upgraded to use JRE 1.7, it starts to use SNI extensions during the SSL 
handshake. If the remote endpoint does not support SNI, the web service call will fail with an 
error message. To solve this issue, do either of the following: 

 l Activate SNI at the remote end point (recommended)

 l If the remote endpoint does not support SNI extensions, and SNI cannot be activated, add 
the following JVMOption<n> parameter either to the sm.ini file, or to the start command of 
the servlet(s) in the sm.cfg file:

JVMOption2:-Djsse.enableSNIExtension=false

To install the Server update:
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 1. Stop all Service Manager clients.

 2. Stop the Service Manager server.

 3. Make a backup of the Server installation directory. See also "Backout Instructions" on page 39.

 4. Delete the RUN/tomcat directory. Tomcat in this directory will be upgraded to version 6.0.36 
when you extract the server files later.

 5. Delete the RUN/lib directory.

 6. For Windows and Linux platforms, delete the RUN/jre directory. 

Note: This step is required only when you are upgrading from a server version earlier than 
9.21p7. This is to avoid conflicts between the old 1.6-based JRE and new 1.7-based JRE.

 7. Extract the compressed files for your operating system into the main Service Manager 
directory on the server. The default path is: C:\Program Files\HP\Service Manager 
9.21\Server.

 8. For UNIX servers, set the file permissions for all Service Manager files to 755.

 9. For UNIX servers, manually upgrade to JRE1.7.

 a. Install either JDK1.7 or JRE1.7 for your specific platform.

Solaris JRE1.7 (update 15  or greater)

HP-UX JRE1.7 (JRE_7.0.04 or greater)

AIX JRE1.7 (SR4 or greater)

 b. Set your JAVA_HOME environment variable to point to JDK1.7 (if you have 
JDK1.7 installed) or JRE1.7 (if you have only JRE1.7 installed).

 c. Execute \RUN\removeLinks.sh to remove the old symbolic links and then execute 
\RUN\setupLinks.sh to create new symbolic links. 

 d. Run the following command to check that the JRE version is 1.7: 

RUN\jre\bin\java –version

 10. If you have made any customizations/changes to the original RUN/tomcat folder, restore them 
in the new RUN/tomcat folder.

 11. Make sure the server is stopped, and run the sm -unlockdatabase command.
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Note: The purpose of this step is to prevent stale license information from being kept in 
the system. In a scaling implementation, you can run this command from any one of your 
servers.

Caution: This step is required the first time you upgrade to 9.21p6 or later; it is also 
required whenever you change the server’s IP address after your upgrade to 9.21p6 or 
later.

 12. Restart the Service Manager server.

 13. Restart the Service Manager clients.

 14. Check the version in Help > About Service Manager Server. The server should be Release: 
9.21.624.

Application Unload Installation
If a platform fix (in most cases, a server fix) also requires an applications change to resolve the 
relevant issue, an unload file is provided. Unload files introduced in earlier patches are also included 
in this cumulative release. If you have not already applied them for a previous patch, you should 
also apply the unload files that are intended for your applications version. For more details about 
these applications updates, see the Release Notes for those patches.

This patch release includes the unload files that come with the server update. When you extract 
sm9.21.624-P7_<OS>.zip (or .tar), it will add the files to the following directory:

[SM Server Root]\platform_unloads ([SM Server Root]/platform_unloads)

Note: Unload files should be installed in their patch order. That is, those introduced in patch 1 
should be applied first, then those introduced in patch 2, and so on. However, unload files 
introduced in the same patch can be installed in a random order, unless otherwise specified.

Unload File Naming Convention
The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where:

 l <CR_ID>: The identification number of the applications defect that the unload file fixes. For 
example, QCCR1E12345. Note that this is always the number of the parent CR of a CR family 
(if any).

 l SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For 
example, SM921P2, which means the unload file comes with the server updates in Service 
Manager 9.21 patch 2 and should be used for patch 2 or higher.

HP Service Manager (9.21) Page 51 of 58

Patch 7 Release Notes
Installation Notes



Note: Sometimes this portion contains an additional hot fix number, for example, 
SM711P16HF8. This example means the unload file is intended for Service Manager 7.11 
patch 16 Hot Fix 8 or higher.

 l SMxxx: The Service Manager applications version that requires the unload file. For example, 
SM711, which means the unload file is intended only for Service Manager applications version 
7.11.

Note: If the applications version suffix is omitted, the unload file is then intended for all 
applications versions compatible with the server version, unless otherwise specified. For 
example, for Service Manager server 9.21, the compatible applications versions are 7.11 
and 9.20.

New Application Updates Introduced in This Patch
The following table lists the new application updates introduced in this release.

Unload file Used for 
appplicati
ons 
version(s)

Description

  No unload file is newly introduced in Service Manager 9.21 
patch 7.

Application Updates in Previous Patches
The following table lists the unload files introduced in previous patch release.

Unload file Introduced 
in 9.21 
patch

Used for 
applications 
version(s)

Description

QCCR1E29881_
SM921P1.unl

P1 7.11 and 9.20 Includes application changes to reduce 
database I/O on login.

QCCR1E57766_
SM921P1.unl

P1 7.11 and 9.20 Includes application changes to reduce 
jgroups traffic on login.

QCCR1E59753_
SM921P2.unl

P2 7.11 and 9.20 Includes application changes to fix the ToDo 
bar.
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Unload file Introduced 
in 9.21 
patch

Used for 
applications 
version(s)

Description

QCCR1E31545_
SM921P2_
SM711.unl

P2 7.11 Prevents backslashes included in a 
template from being duplicated in the output.

Note: This file is not required for 
Applications 7.00.

QCCR1E31545_
SM921P2_
SM920.unl

P2 9.20 Prevents backslashes included in a 
template from being duplicated in the output.

QCCR1E48580_
SM921P3_
SM711.unl

P3 7.11 Enables translation of Display/Value lists on 
dynamic forms. This is a required fix for the 
Export to Excel redesign.

QCCR1E48580_
SM921P3_
SM920.unl

P3 9.20 Enables translation of Display/Value lists on 
dynamic forms. This is a required fix for the 
Export to Excel redesign.

QCCR1E48513_
SM921P3_
SM711.unl

P3 7.11 Lists the records in the right group order 
when a record list is refreshed.

QCCR1E58562_
SM921P3_
SM711.unl

P3 7.11 Includes applications changes for Export to 
Excel redesign.

QCCR1E58562_
SM921P3_
SM920.unl

P3 9.20 Includes applications changes for Export to 
Excel redesign.

QCCR1E67610_
SM921P4.unl

P4 7.11 and 9.20 Enables you to block potentially dangerous 
attachments.

QCCR1E67072_
SM921P4.unl

P4 7.11 and 9.20 Enables you to improve the Knowledge 
Management update process (KMUpdate) 
performance.

QCCR1E67647_
SM921P5.unl

P5 7.11 and 9.20 Updated the scmessage record from "Doc 
Engine call failed” to include the message 
number.

QCCR1E70163_
SM921P5_
SM711.unl

P5 7.11 Prevents the KMUpdate process from 
terminating when the Search Engine server 
is shut down or an indexing document error 
occurs.
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Unload file Introduced 
in 9.21 
patch

Used for 
applications 
version(s)

Description

QCCR1E70163_
SM921P5_
SM920.unl

P5 9.20 Prevents the KMUpdate process from 
terminating when the Search Engine server 
is shut down or an indexing document error 
occurs.

QCCR1E71099_
SM921P6_
SM711.unl

P6 7.11 Enables the Value Lists to be displayed 
instead of the data directly retrieved from the 
database in a QBE list when adding a field 
by using Modify Columns.  

QCCR1E71099_
SM921P6_
SM920.unl

P6 9.20 Enables the Value Lists to be displayed 
instead of the data directly retrieved from the 
database in a QBE list when adding a field 
by using Modify Columns. 

 

Applying Unload Files

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are 
recommended to use Unload Manager to load an unload file, because Unload Manager can 
help you create a backup of your old data and reconcile conflicts during the installation of the 
unload; if your application version is other than any of these, Unload Manager is not available 
and you can use Database Manager instead. 

To load an unload file using Unload Manager:

 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details 
of the unload file appear.

 4. Double-click a conflicting object in the table to open the merge tool:

 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.
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 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To load an unload file using Database Manager:

 1. Make sure the Windows client is configured for server-side load/unload.

 a. From the Windows client, go to Window > Preferences > HP Service Manager.

 b. Unselect Client Side Load/Unload if is flagged.

 c. Restart the Windows client.

 2. Open Tailoring > Database Manager.

 3. Right-click the form or open the More Actions menu and select Import/Load.

 4. Browse to the unload file, and view the contents of an unload file before importing it by clicking 
List Contents.

 5. Make a backup copy of all files to be modified by this unload. For detailed steps, see "Backout 
Instructions" on page 39.

 6. Fill in the following fields.

Field Description

File Name Type the name and path of the file to 
load.

Import Descriptor Since unload files do not require an 
Import Descriptor record, leave this 
field blank.

File Type Select the source operating system 
of the unload file.

Messages Option —
All Messages

Select this option to see all 
messages that Service Manager 
generates loading the file.

Messages Option — 
Totals Only

Select this option to see only the total 
number of files Service Manager 
loads.

Messages Option — 
None

Select this option to hide all 
messages that Service Manager 
generates when loading the file.

 7. Click Load FG.
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ODBC Driver Update Installation

Note: This release does not contain the ODBC .zip file that has been shipped with the 
SM9.21p6 release.

You can download the zip file from 
http://support.openview.hp.com/selfsolve/document/KM00234051.

The ODBC Driver update contains the following updated files:

 l Scodbc32.dll

 l sci18n.dll

 l sccl32.dll

To install the ODBC Driver update:

 1. Extract the files to your ODBC Driver installation folder, for example: C:\Program 
Files\Peregrine Systems\ServiceCenter 6.2\ODBC Driver.

 2. When prompted, replace the three old DLL files with the new ones.

Knowledge Management Import Utility Update 
Installation

The Knowledge Management Import Utility was updated for QCCR1E71341 and QCCR1E59746 in 
Service Manager 9.21 Patch 5. However, cerntain files were missing in the Service Manager 9.21 
Patch 5 release build. Now, the updated Knowledge Management Import Utility (km-import-
9.21.zip) is wrapped in sm9.21.624-P7_KM.zip together with this patch release.

To install the knowledge Management Import Utility Update:

 1. Extract km-import-9.21.zip in the Knowledge Management package (sm9.21.624-P7_
KM.zip) to a local drive.

 2. For detailed instructions on the use of the import utility, see the README file packaged in the 
km-import-9.21.zip file.
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Service Manager Verified Environments
The Compatibility Matrix lists supported versions of operating systems, browsers, HP Software 
products, and other compatibility and support information.

Note: Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require an active support contract. To find more information about support access levels, go to      
Access levels.

To register for an HP Passport ID, go to      HP Passport Registration.

To access the Compatibility Matrix:

 1. Use a browser to navigate to the Software Support Online (SSO) web page:

http://support.openview.hp.com/sc/support_matrices.jsp

 2. Log on with your Customer ID and password or your HP Passport sign-in.

 3. Navigate to the applicable information.
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Local Language Support
UTF-8 is part of the Unicode standard, which enables you to encode text in practically any script 
and language. Service Manager 9.21 supports UTF-8 as an encoding method for new or existing 
data. It can support multiple languages that adhere to the Unicode standard on the same server.
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